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Riepilogo - ESSENTIALS Obiettivi di apprendimento

Introduzione ad EndNote 2025 – navigazione e componenti

1 – Creazione e gestione della Library e delle Referenze

a – Creare la tua Library: il Database delle Referenze

b – Popolarla via Direct Export, Import o creazione di singole Referenze

c – Novità 2025 per le Referenze: il Research Assistant = Intelligenza
artificiale nel documento, l’integrazione con Web of Science

2 – Organizzazione ed arricchimento delle Referenze

a – Organizzare le Referenze in Gruppi

b – Integrare le Referenze con il Full Text

3 – Creare bibliografie, con Ms Word o Google Docs

a – Creare e formattare una bibliografia per il tuo articolo

b – Gestire gli stili citazionali



EndNote 2025  ADVANCED Obiettivi apprentimento

1 – Conservare e condividere la tua library

 a – Opzioni di Safety per la tua Library:  

  backup: copia o compressione, 

  sincronizzazione con EndNote Online 

       b – Condividere una Library o un Gruppo

2 – Manutenzione delle referenze della tua Library

       a – Identificare e rimuovere I duplicate nella Library

       b – Identificare articoli ritirati nella library usando Retraction Watch

       c – Usare le funzionalità di editing collettivo
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3 – Funzionalità Avanzate di Cite While You Write (CWYW)

    a – Personalizzare uno stile citazionale

    b – Aggiungere le citazioni nelle note pagina

    c – Nuovo con 2025:  Trova una rivista in CWYW, Citare da un PDF

 Appendice:

       a – Importare referenze con la Online search

       b – Cercare all’interno della intera Library o in singoli gruppi o group sets

       c – Usare altri livelli di classificazione per le referenze

       d – Usare le Terms Lists per armonizzare i nomi per tutte le referenze

       e - Attivare ed usare EndNote Click per trovare il pdf degli articoli

EndNote 2025  ADVANCED Obiettivi apprentimento



1 – Conserva e condividi 
la tua libreria



Obiettivi 
della 
sessione

• Crea backup per conservare e ripristinare 

la libreria di EndNote

• Sincronizzare la libreria con EndNote

Online

• Condividi la tua libreria o singoli gruppi



Metodi per conservare la copia di 
una libreria EndNote per backup
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Copiare la libreria di EndNote

Il modo più semplice per eseguire il backup della libreria è 
creare una copia.  

Nella libreria che si vuole copiare, vai al menu File e seleziona 
Save a Copy… che si riferisce alla Libreria presente e ti 
chiederà di salvarla con un nome con l’elemento ‘copy’. Sia il 
file .enl che la cartella Data saranno copiati, col nuovo nome.
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La copia della libreria

La libreria risultante creata tramite 
‘Save A Copy’ include un nuovo file  
enl e la cartella Data associata per 
questa nuova copia di backup della 
libreria di EndNote.

Questa nuova copia è una replica 
esatta della tua libreria, e può essere 
archiviata o condivis, 
indipendentemente dalla libreria 
originale
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Libreria EndNote compressa
Un altro modo per eseguire il backup della tua libreria è quello 
di Compress (comprimere) la Library.  

Nella Libreria corrente, vai al menu File e seleziona Compress 
Library (.enlx)… che si riferisce alla libreria presente e ti 
chiederà di salvarla con l’estensione .enlx. Questo creerà un 
singolo file .enlx con lo stesso nome della libreria.
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Configurazione delle impostazioni di Compress Library

Salva una copia completa per backup o una 
sezione della tua library per condivisione offline:

• Conserva I settaggi di default della finestra 
Compress Library per includere tutti I contenuti 
della library per backup 

[O]

• Scegliere tra Create r Create & E-mail per 
condivisione

• Scegliere tra With File Attachments o Without 
File Attachments per condivisione

• Scegliere tra All References in Library, Selected 
Reference(s), o All References in Group Set

• Clicca su Next per andare allo schermo di 
Salvataggio della Compressed Library (enlx)
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Il file enlx risultante

Una libreria EndNote compressa 
comprende un singolo file con una 
estensione enlx, che contiene sia il 
file enl che la cartella Data associata

Questo file funge da versione 
compatta della libreria, che include 
tutti i riferimenti e gli allegati, 
semplificando il backup o la 
condivisione
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Recupero della libreria

EndNote

Se una libreria si danneggia, potresti ricevere un messaggio 
di errore quando provi ad aprirla o a lavorare con i riferimenti. 

Se non hai una copia di backup di 
una libreria EndNote danneggiata,  
puoi usare il comando Recover
library per riparare il file 
danneggiato.

1. Close the damaged library.
2. From the Library menu, select 
Recover Library. In the information 
panel click OK.
3. In the dialog that appears, locate 
and select the library that needs to be 
repaired, and click Open.
4. EndNote creates a copy of the 
library with the suffix "-Saved" added 
to the name. 



Sincronizzare una libreria di EndNote con 
l'account Web di EndNote e altri dispositivi
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Opzioni di 
sincronizzazione
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1. Sincronizzare una libreria di EndNote con 
l'account Web di EndNote e altri dispositivi

2. Gestisci l'accesso e le autorizzazioni dei membri 
del team per la condivisione della libreria (fino a  
1,000 utenti

3. Monitorare le modifiche in una libreria condivisa 
utilizzando il feed attività



La funzione di sincronizzazione

• La licenza desktop di EndNote ti dà diritto a 
un abbonamento gratuito di 2 anni a 
EndNote online— la versione Web-based di 
EndNote.

• La funzione Sincronizza (Sync) consente di 
sincronizzare i riferimenti (inclusi allegati di 
file e figure) in una libreria desktop di 
EndNote con i riferimenti nella libreria online 
di EndNote.

• Per avviare il processo di sincronizzazione, è 
necessario registrarsi e disporre di un 
account EndNote attivo.

• È possibile creare più librerie in EndNote, 
ma è possibile designare una sola libreria 
alla volta come libreria di sincronizzazione
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• La funzione di sincronizzazione fornisce un 
backup online di tutti i riferimenti e gli 
allegati per la libreria corrente, oltre a fornire 
l'accesso ai riferimenti da qualsiasi luogo 
tramite EndNote online

• È possibile fare in modo che EndNote avvii 
automaticamente il processo di 
sincronizzazione ogni 15 minuti (opera in 
background) selezionando la casella di 
controllo Sincronizza automaticamente nelle 
Preferenze di sincronizzazione



Sincronizzazione della libreria con EndNote Online
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From the main Library window, click the Sync Configuration button, 
or Sync from the Library Menu, and click on the Sync Now button   
to open the EndNote online Login dialog. 

Enter your EndNote Account Credentials, 
or click the Sign-Up button to begin the 
registration and activation process. 
Follow the online instructions



Sincronizzazione della libreria con EndNote Online
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After the first synchronization, you can return to the Sync Status 
in the black left-hand menu, or from Sync in the Library menu,  
to check the last sync or to click on the Sync Now button to 
update manually the synchronization.



Verifica dei dettagli dello stato di sincronizzazione

Check the Sync Status to view the 
latest synchronization details – 
new in 2025: Smarter Sync – 
Real-time sync status indicators:

• Open your synced EndNote library 
and click the Sync Status label in   
the Groups panel

• The message All changes have  
been sent confirms the 
synchronization is complete

• You can copy the status report for 
support by using the Copy option 
from the Edit menu
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New in 2025: Library details in 
the Library Status window



Sincronizzazione della libreria con EndNote Online
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To setup automatic synchronization:

• Go to the Edit menu and select Preferences.

• In the Preferences window go to Sync. 

• In the panel in the middle check the box 
next to Sync Automatically



Sincronizzazione della libreria con EndNote Online
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Your EndNote Online account will reproduce 
all your references, Groups and Shares



Accesso alla libreria Web di EndNote

Accedi alla tua libreria EndNote
sincronizzata da qualsiasi dispositivo 
con una connessione Internet e un 
browser web:

• Vai a web.endnote.com sul tuo 
browser web e accedi con le 
credenziali del tuo account EndNote
Web

• Visualizza o modifica i riferimenti, gli 
allegati e i gruppi oppure aggiungi 
nuovi elementi alla tua libreria da 
qualsiasi luogo
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Sincronizzazione su un altro computer

Una licenza EndNote 2025 per utente 
singolo consente fino a tre installazioni per 
uso personale:

• Dopo aver configurato Sync sul 
dispositivo principale, installa EndNote
2025 su un altro computer utilizzando lo 
stesso codice Product Key

• Scegli Nuovo... dal menu File per creare 
una nuova libreria per la sincronizzazione

• Con la nuova libreria aperta, seleziona 
Sincronizza dal menu Libreria e accedi 
con il tuo account EndNote Web
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In movimento

EndNote è disponibile sia per iPad che 
per iPhone:

• Scarica EndNote dall'App Store di 
Apple e apri l’app

• Accedi con l'account Web di EndNote

• Tocca il pulsante Sincronizza per 
accedere ai tuoi riferimenti, gruppi e 
file allegati sempre e ovunque

© 2025 Clarivate. All rights reserved. 24



Visualizzare la sincronizzazione di EndNote

EndNote Web

EndNote 2025EndNote 2025

EndNote 2025 iPhone

25

A single-user EndNote 2025 license permits the software to be installed on up 
to 3 personal computers concurrently + a free EndNote app for iPhone or iPad



Condividere una libreria o un gruppo 
di EndNote con altri utenti di EndNote
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Condivisione delle librerie

• EndNote 2025 offre agli utenti la 
possibilità di condividere l'intera 
libreria di sincronizzazione con un 
massimo di altri 1000 utenti.

• La condivisione della libreria fornisce 
a interi team l'accesso immediato e in 
tempo reale a un'intera libreria di 
EndNote, ovvero lo stesso insieme di 
riferimenti, allegati, note e 
annotazioni. 

27

• Le modifiche vengono inviate e ricevute 
tramite sincronizzazione, quindi tutti i 
membri della libreria condivisa devono 
avere il desktop attivato con le preferenze 
di sincronizzazione completate ed essere 
connessi a Internet per poter inviare e 
ricevere le modifiche. 

• La condivisione della libreria è consigliata 
come alternativa al salvataggio di una 
libreria su un Drive condiviso o all'invio di 
una copia compressa tramite e-mail a un 
gruppo di collaboratori.



Condivisione della 
libreria

EndNote 2025 ti consente di 
condividere la tua libreria Sync con 
un massimo di 1.000 membri del 
team:

• Assicurati che la libreria di 
sincronizzazione designata sia 
aperta in EndNote 2025

• nella Libreria che desideri 
condividere:

• fai clic sul menu File e seleziona 
Condividi... per iniziare a configurare 
le opzioni di condivisione

28



Nel pannello "Condivisione" che si apre, 
invita i membri del team alla tua libreria 
condivisa per collaborare:

• In the Invite More People field enter the 
email address(es) of the people you wish 
to share the Library with

• In the Permission option select either 
Read & Write or Read Only

• Add a message in the space below, if 
needed

• Click on the Invite button
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Invitare i membri del team 
a condividere la tua libreria



Gestione del team di 
condivisione della libreria

To check the parameters of the shared 
Library, in the ‘Sharing’ panel that 
opens via the same route:

• The Sharing With box will show the list 
of the people you invited and the 
related permission

• The Control submenu allows to remove the 
member, send them a reminder or change 
their rights

• More people can be added in the email 
address box, if needed
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Accettazione dell'invito a una libreria condivisa e 
apertura di una libreria condivisa come membro
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The recipient of the share invite gets 
a notification email, with the option 
to Accept the Invitation.

Once done, (s)he will be able to 
Open the Shared Library via 
the File menu in his/her account



Visualizzare la condivisione della libreria

EndNote Web

EndNote 2025

EndNote 2025 EndNote 2025

iPhone

Team member

Team member

Team member

Team member

Team member

Team member

Team member

Team member
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Condivisione di gruppi

• In your Library, highlight the Group 
you wish to share.

• click the Groups drop-down menu 
and select Share Group to begin 
setting-up the sharing options
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Condivisione di gruppi

In the Sharing Group…panel that opens:

• Enter the email address(es) of the people 
you wish to share the group with

• In the Permission option select either 
Read & Write or Read Only

• Add a message in the space below,             
if needed

• Click on the Invite button
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Condivisione di gruppi

When a Group has been shared, it is 
recognizable by the Heads           icon.

In the panel that opens via the same 
route:

• The Sharing With box will show the list 
of the people you shared the Group 
with and the related permission

• More people can be added in the 
email address box, if needed
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Condivisione di gruppi
• When someone else shares a group with you, 

you’ll see the list of the ‘Groups shared by 
others’ appearing in the black left-hand menu

• Clicking on any of it will open the content of 
the Group in EndNote Online
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Monitorare le modifiche in una libreria 
condivisa usando l’Activity Feed
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Monitora le attività sui tuoi riferimenti condivisi
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Collaborazione

Condividi la tua libreria 
di referenze con un 
massimo di 1.000 altri 
utenti e visualizza un 
registro delle attività per 
utente per monitorare 
l'andamento della tua 
recensione.



Informazioni sugli elementi del feed attività

Tutte le attività dei membri della Libreria 
condivisa disponibili per la revisione includono:

• Aggiunta, modifica, spostamento o ripristino dal 
Cestino e svuotamento del Cestino

• Gli oggetti di libreria includono riferimenti, 
allegati, figure, gruppi e gruppi

• Nuovo membro che si iscrive alla biblioteca 
accettando l'invito

• Quando un utente esegue un'azione più di una 
volta, EndNote consolida tale attività in un'unica 
riga. 

• EndNote elenca questi elementi singolarmente in 
modo che gli utenti possano selezionare la riga di 
attività e passare al gruppo o al gruppo 
impostato per visualizzarne il contenuto



Visualizzare le modifiche correlate alla libreria tramite il feed attività

Selezionando le righe di attività nere vengono 
visualizzate le seguenti informazioni di modifica 
correlate:

• Facendo clic su una linea di attività nera, il feed attività 
viene temporaneamente nascosto e si torna alla 
finestra principale della libreria condivisa

• Un nuovo gruppo temporaneo chiamato Feed attività 
viene visualizzato nel pannello Gruppi della libreria 
sotto il gruppo Tutti i riferimenti

• Esaminare gli elementi di questo gruppo di feed 
attività per confermare le modifiche apportate alla 
libreria condivisa da questo membro del team di 
condivisione della libreria



2 – Gestire i riferimenti alla libreria



Obiettivi 
della 
sessione

• Rileva e rimuovi i riferimenti duplicati

• Identifica gli articoli ritirati nella tua libreria 

usando l'integrazione di Retraction Watch

• Usare gli strumenti di integrazione con Web 

of Science

• Applicare le opzioni di modifica globale ai 

riferimenti



Identificare ed eliminare i riferimenti 
duplicati da una libreria EndNote
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Avvio della ricerca Trova duplicati

Identify duplicate references from 
your EndNote library:

• click the Library  drop-down to select 
Find Duplicates to begin checking 
for extra entries in the group

• Duplicate detection runs on the 
currently viewed group or the entire 
library
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You can perform Duplicate searches in 
Group Sets, Groups and All References



Defining Primary Reference to instruct EndNote 
which item to keep
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Duplicate searching flexibility:

• Press the Primary Reference: drop-down to 
view all available options

• Click Most Complete to instruct EndNote   
to retain the entry with the most metadata, 
whether it's the first entry or a subsequent 
addition

• Choose Newest to retain the most recent 
items in your library

• Select Oldest to retain the original versions 
of each instance of duplicate references

• Press the Keep All Primary References 
button to proceed with the Find Duplicates 
search in a global manner



Confronto di 
riferimenti duplicati

© 2024 Clarivate. All rights reserved. 47

EndNote 2025 searches for duplicate  
references and displays them one                              
set at a time with the primary one:

• Your designated primary reference 
always appears on the left of the side-by-
side Find Duplicates window

• Fields that look different are highlighted 
in grey

• Click Keep This Reference above the 
desired entry to save that reference and 
move the other to the Trash

• EndNote 2025 continues to the next 
duplicate set until done or Cancel is 
pressed during the Find Duplicates 
search



Ignorare un riferimento o l'intero processo 
di confronto affiancato
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Additional options for progressing 
through the Find Duplicates search are 
available:

• Click Skip to leave both references in 
the library intact and unchanged. They 
will appear in a temporary Duplicate 
References group so you can review 
them later

• Press Cancel to bypass this side-by-side 
comparison process entirely. This will 
proceed to identify all the duplicates in 
one go.



Utilizzo del gruppo Riferimenti duplicati

Choosing to Cancel or Skip any duplicate 
entries will result in EndNote 25 displaying a 
temporary Duplicate References group:

• If you ignore the Duplicate References group, 
as you don’t need to make any additional 
changes, EndNote won't show this group 
again once you reopen your library

• Alternatively, view the references listed within 
the Duplicate References group to compare 
these items visually

• Press command (macOS) or Ctrl (Windows) 
on your keyboard while clicking on items in 
this group to toggle its highlighted status

• Right-click over the Duplicate References 
group and select Move References to Trash 
on the contextual menu to send the 
highlighted items to the Trash group
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Gestire i riferimenti rimossi nel Cestino

Yo
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Scelta dei campi di confronto 
Trova duplicati

You can select the criteria that determine 
which references are kept by default. Up to 
17 different fields can be configured from 
the EndNote library when comparing 
references and determining duplicate items:

• Select Preferences from the Edit menu 

• In the EndNote Preferences panel, select the 
Duplicates tab on the left to view all the Find 
Duplicates configuration options

• Set the Criteria in EndNote to compare fields 
for Exact match or Ignore spacing and 
punctuation for a lenient search

• Choose Most complete, Newest, or Oldest 
to designate your primary reference criteria
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Identifica gli articoli ritirati nella tua libreria 
usando l'integrazione di Retraction Watch
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Evita di includere studi ritirati nella tua recensione
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Citing retracted 
papers

• Embeds errors 
deeper into the 
scholarly record.

• May alter the 
outcomes of 
systematic reviews.

The Economist: https://www.economist.com/graphic-detail/2021/06/26/zombie-
research-haunts-academic-literature-long-after-its-supposed-demise 
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Avviso di ritrattazione in EndNote

CWYW alertsAutomatic groups Retraction Watch details

Temporary ‘Retractions’ group 
automatically created after 

retracted papers are identified.

Expandable “Retracted 
publication” alert with more 

details from Retraction Watch.

Warnings displayed next to 
retracted search results as you 
insert and format references.
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Avvisi di ritiro

EndNote 55



Ricezione di avvisi di ritiro

• EndNote 2025 checks all active 
libraries for retracted articles 
flagged by Retraction Watch

• Displays a temporary Retractions 
group when retracted articles are 
found

• Click on the Retractions group to 
review any identified retracted 
articles in your library
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Individuazione delle notifiche di ritiro

• Click on a retracted citation to 
view the Retraction Watch 
reasons for retraction

• The Retracted Publication 
Panel shows retraction details 
and additional metadata
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Avvisi di ritiro in Cite While You Write
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• EndNote 2025 provides a 
Retraction Alert button in 
Microsoft Word

• The alert appears if any retracted 
articles are cited in your Word 
document

• Click the Retraction Alert button 
to view a summary of all cited 
retracted references



Identificazione della ricerca ritirata

• Warning symbols appear for 
retracted references in Cite 
While You Write

• Select the flagged reference to 
view the Retraction Watch 
notice

• Retraction details and citation 
metadata appear in the 
Retracted Publication Panel
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Managing retraction alerts

• View a detailed summary after 
citing a retracted article

• Click Read More to access the 
publisher’s retraction notice

• Use Edit Library Reference to 
review and update the citation

• Click Done when finished 
reviewing
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Integrazione con Web of Science



Strumenti Web of 
Science in EndNote
• 3 options that from a reference in 

the EndNote  library allow to:

- 1 - view the source record, or 

- 2 - view a list of related records, or

- 3 - create a Citation Report,

for the same work in Web of Science

• Possible only if the reference contains a 
Web of Science identification number.

• Note: A Web of Science subscription is 
required to access this content.

1

2

3



1



Web of Science 
tools in EndNote2



Web of Science 
tools in EndNote

3



Opzioni di 
modifica globali
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1. Apply the Change/Move/Copy Fields 

function to edit multiple records at once

2. Use Find and Replace to update terms or 

correct errors in your library globally

3. Automatically update existing references 

using Find Reference Updates



Applica la funzione Modifica/Sposta/Copia 
campi per modificare più record 

contemporaneamente
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Selezione dei riferimenti 
di libreria da modificare

• EndNote applies your edits to the 
references currently visible in your library

• To edit all references, select All References 
in the Groups panel

• To edit specific references, choose a group 
or group set from the Groups panel
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Applicazione di 
modifiche simultanee

To start applying changes to your references, 
go to the Library menu and select 
Change/Move/Copy Fields... to begin
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Passaggio alla scheda 
Sposta/Copia campi

• The Change/Move/Copy Fields window 
offers two tabs: Change Fields and 
Move/Copy Fields

• To move or copy data between fields, click 
the Move/Copy Fields tab

© 2025 Clarivate. All rights reserved. 70



Definizione dell'azione 
di modifica preferita

• The Move/Copy Fields tab provides options 
for moving or copying data between fields 
in your library

• Choose the field you want to move or copy 
data from

• Select the field where you want the data to 
be moved or copied

• Optionally, configure settings to specify how 
you want EndNote to treat the data during 
the move or copy process
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Designazione dei 
campi da includere

• Once you’ve set up your move or copy action, 
confirm the process

• Click OK to apply your changes and update 
your library

• Click Cancel to stop the process and discard 
any changes made
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Navigazione nella scheda 
Campi di modifica

• The Change/Move/Copy Fields window 
offers tabs for different actions

• Click the Change Fields tab to modify the 
content of a field without moving or 
copying it to another field
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Scelta dei campi 
da modificare

• The Change Fields tab allows you to 
select the fields you want to modify

• Choose the field you want to modify from 
the In drop-down menu

• Enter the new content you want to apply 
to that field in the text box

• click OK to apply the changes and update 
your library

• Click Cancel to stop the process without 
making changes

• Press the Help button to view detailed 
instructions and guidance
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Conferma dei campi 
Modifica/Spostamento/Copia

• After applying your changes, EndNote 
will display a confirmation message with 
the number of records updated

• Click OK to finish the process and exit the 
confirmation message

• Click Cancel if you wish to stop the 
process and revert any changes made
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Utilizza Trova e Sostituisci per aggiornare i 
termini o correggere gli errori nella tua 

libreria a livello globale
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Selezione dei riferimenti 
per la sostituzione dei 
termini

• EndNote applies global edits to 
references that are currently displayed

• Select All References in the Groups 
panel to apply edits to your entire library. 
To edit only specific references, choose a 
group or group set
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Avvio del processo di 
ricerca e sostituzione

• Begin by searching for a specific term 
or phrase in your library, then replace 
it with a new value

• To start, go to the Library menu and 
select Find and Replace... to begin 
the process
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Scelta dei campi per trovare i termini

• The Find and Replace tool works within one 
field at a time

• Open the Select a Field menu to select the 
field you want to search in

• Enter the term you want to find in the Find 
field, then type the replacement in the 
Replace with field

• Use the Insert Special menu to include tab  
or carriage return characters if needed

• Optionally, adjust settings for Match Case, 
Match Word, and Retain Capitalization

• When you’re ready, click Change to proceed.

• Or click Cancel to stop the process
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Conferma del processo

• Review the changes you’re about 
to apply

• Click OK to apply your changes

• Click Cancel to stop the Find and 
Replace process
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Aggiornare automaticamente i riferimenti 
esistenti utilizzando Trova aggiornamenti 

riferimenti
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Selezione dei riferimenti 
da aggiornare

1. Highlight at least one reference for the 
Find Reference Updates search

2. To select non-consecutive references, 
hold command (macOS) or ctrl 
(Windows) and click each reference

3. To select a range of references, hold 
shift and click the first and last reference 
in the range
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Avvio degli aggiornamenti 
di ricerca dei riferimenti

1. After selecting the references you want 
to update

2. Click the References drop-down and 
select Find Reference Updates

3. A progress bar will appear showing the 
update progress
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Ricerca tramite Trova 
aggiornamenti di riferimento

1. Update All Fields to replace all 
metadata

2. Update Empty Fields to replace 
only missing metadata

3. Edit Reference to manually 
select new metadata

4. Skip to leave the reference 
unchanged

5. Cancel to stop the update 
process
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Applicazione delle 
modifiche batch

1. Select Yes to apply changes 
to all remaining references

2. Alternatively, select No to 
apply changes one by one
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Completamento degli 
aggiornamenti di Trova 
riferimento

1. EndNote will confirm once all updates are 
complete

2. Optionally, check Do not show this 
message again to avoid future alerts

3. Press OK to close the confirmation dialog
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3 – Funzionalità avanzate 
di Cita mentre scrivi



Obiettivi formativi

•Editare e personalizzare uno stile di citazione

•Aggiungere citazioni nelle note a pie’ pagina

•Nuovo in EN 2025: 

1.Citare da un PDF

2.Trovare una rivista in Cite While You Write

•Spostarsi da EndNote desktop a Online e 
viceversa in CWYW in Word
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Personalizzare uno stile di output 
in EndNote 2025



Modificare o personalizzare uno stile di citazione in EN2025

In this example we need to create a version of the 
Vancouver style with square brackets

In EndNote 2025, Go to the Tools Menu> Output Styles

Select Edit “Vancouver” or go the “Open Style Manager…” 90EndNote 21 essentials

Styles can be edited, or you 
can create a custom copy. 



Modificare o personalizzare uno stile di citazione in EN2025

In the window of the style, open the 
File menu and chose Save As…. 

Save the style with a different name, 
e.g. “Vancouver Square Brackets”
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Modificare o personalizzare uno stile di citazione in EN2025

1 - You can now open the 
Edit of the new style

92

2 - In the edit window 
go to the option 
Citations > Templates 
in the menu on the left.

3 - In the central panel change the brackets 
of the original Vancouver style into the 
square brackets. 

4 - Don’t forget to 
save the change: 
menu File>Save



Applicare lo stile personalizzato in CWYW in Word

To apply your custom style 
in CWYW, go to the Style 
drop-down menu and 
select the new style name, 
or go to Select Another 
Style and find the style in 
the complete list.

93EndNote 21 essentials



Footnotes for Google Docs

To insert footnotes into Google Docs, follow the steps 
below:

1. Open Google Docs.
2. Click on “Insert” > “Footnote” OR using the hotkey:
Windows: [CTRL+ALT+F]
Mac:  [OPTIONS+COMMAND+F]
3. Click on “Extension” > “EndNote 2025 Cite While 
You Write” and log in with your credentials.
4. Select the reference and click on “Insert Citation.
5. Click on “Update Citation” to format it.

Aggiungere le citazioni in footnotes, in Google Docs

https://support.clarivate.com/Endnote/s/article/Footnotes-for-Google-Docs?language=en_US


Aggiungere le citazioni in footnotes, in Word

Footnotes for Word Online

To insert footnotes into Word Online, follow the 
steps below:

Open Word Online

1.Click on “References” > 

2.“Insert Footnote” OR press on [CTRL+ALT+F] for 
Windows/ [OPTIONS+COMMAND+F] for macOS.

3.Now click on "EndNote”

4.Select the reference and click on “Insert Citation

5.Click on “Update Citation” to format it.

https://support.clarivate.com/Endnote/s/article/Footnotes-for-Word-Online?language=en_US#:~:text=Ensure%20the%20Cite%20While%20You%20Write%20plugin%20has,macOS.%20Click%20on%20%E2%80%9CUpdate%20Citation%E2%80%9D%20to%20format%20it.


Nuovo in EN2025: 
Citare da un PDF

Quote & Cite from Any PDF

1. In the Word doc, click where you                              
want to add the Citation, then click                           
on Go to EndNote

2. In EndNote, go to the PDF document, 
highlight the text you want to include,                
and click on the Double Quote symbol.

3. The text and related citation will be 
added to your word document
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Nuovo in EN2025 
Trovare una rivista

Built-In Journal Suggestions

• Currently available in CWYW x 
Google Docs

• Uses manuscript content to 
suggest journals

• Replaces the separate 
Manuscript Matcher tool
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Nuovo in EN2025 
Trovare una rivista

Built-In Journal Suggestions

• Currently available in CWYW x 
Google Docs

• Uses manuscript content to 
suggest journals

• Replaces the separate 
Manuscript Matcher tool
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Citazioni di articoli che 
appaiono inEndNote



CWYW in Word: spostamento da EndNote 
Online a EndNote 2025 (e vice versa)
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In “CWYW” Word - passare da EN Online a Desktop
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2

In “CWYW” Word - passare da EN Online a Desktop



Maggiori informazioni sulle 
novità in EndNote 2025

1. Key Takeaway (by Generative AI)

2. Find a Journal in Cite While You Write

3. Cite from a PDF

4. Summary Panel Redesign

5. Web of Science Citing Articles

6. Enhanced Sync process visibility

7. Option to use dashes for Pages and Date 
Ranges

8. Library details in the Library Status window

9. Updates to the Edit tab
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Riprogettazione del 
pannello di riepilogo

All your reference information—at a glance

• Unified view: citation, notes, summary, 
preview

• Fewer clicks to key details

• Cleaner, visual layout
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Aggiornamenti delle 
schede Modifica

Quick Edits. Clear Insights.

• Cleaner Edit Tab layout

• Easier to update multiple records
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Supporto En Dash

Style-Savvy Citations:                           
Hyphen vs. En Dash

• New dropdown in Output Style Editor

• Choose between hyphen or en dash

• Supports APA, Chicago, and others
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RISORSE DI SUPPORTO



EndNote supporto del prodotto

Clarivate ha un team di esperti  
EndNote disponibili Lunedì - Venerdì, 
via chat, email, o telefono e dallo 
EndNote support portal per offrire 
assistenza con domande e problemi.

Il Knowledge Center contiene 
dettagliati articoli e guide

https://endnote.com/downloads/

https://support.clarivate.com/Endnote

https://support.clarivate.com/Endnote


EndNote LibGuide

Visitate la EndNote LibGuide per trovare moduli eLearning, video tutorials, il calendario dei webinars, quick reference 
guides e molti altri materiali

https://proquest.libguides.com/endnote
https://proquest.libguides.com/endnote
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IL Vostro feedback 
e’ molto importante!

Per cortesia dateci la vostra 
valutazione con il feedback form 
(anche in Italiano)
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1
1

IL Vostro feedback 
e’ molto importante!

Per cortesia dateci la vostra 
valutazione con il feedback form 
a questo link:

https://tinyurl.com/EN25Statale2 

  O con il QR Code  ➔ 

https://tinyurl.com/EN25Statale2
https://tinyurl.com/EN25Statale2


ADVANCED riepilogo obiettivi apprendimento

1 – Conservare e condividere la tua library

 a – Opzioni di Safety per la tua Library:  

  backup: copia o compressione, 

  sincronizzazione con EndNote Online 

       b – Condividere una Library o un Gruppo

2 – Manutenzione delle referenze della tua Library

       a – Identificare e rimuovere le referenze doppioni nella Library

       b – Identificare articoli ritirati nella library usando Retraction Watch

       c – Usare le funzionalità di editing collettivo
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3 – Funzionalità Avanzate di Cite While You Write (CWYW)

    a – Personalizzare uno stile citazionale

    b – aggiungere le citazioni nelle note pagina

    c – Nuovo con 2025:  Trova una rivista in CWYW, Citare da un PDF

 Appendice:

       a – Importare referenze con la Online search

       b – Cercare all’interno della intera Library o in singoli gruppi o group sets

       c – Usare altri livelli di classificazione per le referenze

       d – Usare le Terms Lists per armonizzare i nomi per tutte le referenze

       e - Attivare ed usare EndNote Click per trovare il pdf degli articoli

ADVANCED riepilogo obiettivi apprendimento



© 2025 Clarivate. All rights reserved
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Appendice

• Importare referenze con la ricerca online

• Eseguire ricerche in singoli gruppi, set di 
gruppi e nell'intera libreria

• Usare i livelli di classificazione per i 
riferimenti con colonne personalizzate nella 
visualizzazione della tabella

• Usare le Terms Lists

• Attivare ed usare EndNote Click per rilevare il 
pdf degli articoli



Online Search



Online Search

• EndNote’s search interface provides a simple 
way to do basic searches of EndNote Libraries 
and Online Databases. 

• EndNote is able to provide access to these 
remote sources using the information retrieval 
protocol Z39.50, widely supported by libraries 
and information providers around the world.     
It provides a convenient method to access their 
library catalogs and reference databases.

• Each service listed in the Online Search group    
is setup by a Connection File



Online Search

• To customize the Online Search 
group and add more services, go          
to the Plus sign. In the opening  
panel you’ll see the entire list of 
Connection files of the different 
databases.

• In the Quick Search box insert        
the name or part of the name of     
the service you wish to add.

• Select the desired service in the          
top window and click on the           
Choose button

• Notice the total number of pre-
incorporated connection files. 

• More can be added in the 
Downloads site.



Online Search

• To search the Databases, 
select one, fill the search 
form, click on Search and 
the authentication will start. 

• This particular service  
requires the authentication  
via Userid/Password



Online Search

• After launching the search with 
the Search button, the results will 
be shown progressively in the 
central window

• The progress and final total nr of 
results is shown in the “Retrieve 
results” row

• In the list below, select the 
interesting results and move 
them into your Groups



Online Search

Open the Connection Manager      
to add more Connection Files,            
Edit one, or Get more on the Web 

https://endnote.com/downloads/connections/



Perform several levels of searches 
across individual references, 

groups, group sets                                       
or the entire library
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Searching within an individual 
reference

• Open the reference and click Edit to view 
the full details

• Click the magnifying glass icon to use 
the Find feature

• Type your search term and use the Next 
or Previous arrows to locate matches
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Searching within PDF file 
attachments

• Click the PDF tab in the Reference Panel 
to view the attached file

• Select the magnifying glass icon to open 
the Find feature

• Enter a term and use Next or Previous 
arrows to navigate the results in the PDF
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Search your references - 
Simple Search

• Search your entire library using a single 
text box, including PDFs and PDF Notes

• Enter words or phrases to perform a full-
library search

• The space between multiple terms works 
as an implied AND

• Use double quotes (" ") to search for 
exact phrases

© 2025 Clarivate. All rights reserved. 126

Both Simple and Advanced search can be executed at the single Group level 
(select the Group before) or a the entire Library level (select All References)



Search your 
references - 
Advanced 
Search

• Build complex searches using multiple 
fields and Boolean operators

• Apply comparison rules for precise filtering

• Save and reload your search strategies             
for future use
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Selecting the Fields

• Use the Field list to target 
specific areas in a reference 
(e.g., Author, Year, Title)

• EndNote defaults to 
common fields, but all 
library fields are available

• Selecting the right field 
helps narrow your search 
effectively
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Selecting the Comparison options

• Choose how each field is 
evaluated in your search

• Contains (anywhere in the 
field – default choice)

• Is (exact match)

• Relative values

• Exact position in the field 
or word
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Entering your search terms

• Enter the word or phrase in 
the Search box next to the 
related field

• Define up to 10 search 
terms across different fields

• You can type or paste terms, 
including special characters 
(e.g., tab or paragraph 
breaks)
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Selecting the Operators

Combine search lines using 
Boolean operators:

• AND – narrows results (both 
conditions must be met)

• OR – broadens results (either 
condition can be met)

• NOT – excludes results 
(removes matches to the 
second condition)
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Use more classification layers for the references 
with custom columns in the table display



Customize the layout of the reference table

You can customize the view 
of the table, adding 
columns for additional 
layers of classification. 

To add columns, hover over 
the Columns Headings 
ribbon and a Settings Icon 
will appear on the right.

Click on it to open the 
Preferences window
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Customize the layout of 
the reference table

This will show the Preferences window 
open to the Display Fields section.

Here you can add more columns, up to 
10, and customize the headings.

In this case, we want to add a column 
Label, to show the name of the Group 
in which the references have been 
arranged.

We can also add a description of the 
search used to retrieve the record, or 
the Name of the Database.
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Customize the layout of the reference table

The table will now show 
the added column(s).

You can fill manually the 
content of these 
columns to add a layer 
of classification
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Customize the layout 
of the reference table

• To fill the added columns with data, select the 
relevant references, then go to the Library 
menu and select Change/Move/Copy Fields...

• In the panel that opens, select the field you 
need to fill, then add the text in the box below, 
then click on OK
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Customize the layout 
of the reference table

Now the Group column in the 
table shows the terms just 
entered, which are indication            
of the Group name

So when you display All the 
References, you can identify in 
which Group each of them are.
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Utilizzo delle liste di termini -
armonizzazione



• Term lists are used to store terms such as 
keywords, author names, journal names

• The stored terms are used when entering 
references to improve consistency and 
accuracy of information in your library. 

• Term Lists are Automatically Maintained – 
populated by the data of the references as 
they are created.

1. The terms in the lists can be edited

2. The lists can be imported or exported,

3. Assigned to specific fields

14
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Terms Lists
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Abbreviazioni delle 
riviste
• The Journals Term List option can help 

to streamline reference/bibliography 
production

• contains the full journal name plus one 
or more abbreviations for each journal

• journal names and abbreviations can         
be added to the list

• can be saved and used in successive 
reviews to save time standardizing 
references

• Load Journals Term List when you  
create a new library

14
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Activate and use EndNote Click 
to detect the pdf of articles
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Use EndNote Click to capture the pdf articles
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Use EndNote Click

Configure EndNote 
Click settings
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Import pdf articles with EndNote Click

Have EndNote 2025 open behind: 
the export will work smoothly
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Import pdf articles with EndNote Click

First the metadata will be 
imported in EndNote2025,
then the pdf
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